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Chapter 1 – Overview of AWM 
 
What AWM Does 
AWM is a planning/design tool for animal feeding operations that can be used to estimate the 
production of manure, bedding, process water and determine the size of storage/treatment 
facilities.  The procedures and calculations used in AWM are based on the USDA-NRCS 
Agricultural Waste Management Field Handbook. 
 
AWM uses the concepts of “Manure Master” to produce a gross nutrient balance but does not 
track mass or concentration of nutrients for determining land application rates or for other 
utilization components. 

 
Features of AWM 
 Provides manure characteristics for eight animal types with the ability to modify these 

characteristics and add animal types as necessary. 
 Accounts for bedding, wastewater, flush water and other additions to the waste stream. 
 Tracks liquid and solid wastes produced in multiple locations through multiple waste 

streams. 
 Develops separation, storage, and treatment components for liquid and solid wastes that 

are defined as “Management Trains”. 
 Estimate precipitation and runoff entering the “Management Train”.. 
 Sizes storage facilities using a defined storage period or drawdown dates specified by the 

user. 
 Develops a monthly water and waste budget for each treatment/storage component. 
 Provides a calculator for converting units and performing computations. 
 Produces a gross nutrient balance from target yields and crop acreage specified for crops 

listed in the crop database. 
 Provides a schematic drawing for each treatment/storage component. 
 Generates a standard or custom report to document the system design. 

 
User Support 
User support can be obtained from USDA-NRCS National Water and Climate Center or the 
National Water Management Center.  Contact either Bruce Wilson at (503) 414-3076/ 
bwilson@wcc.nrcs.usda.gov, William Boyd at (501)210-8917/ William.Boyd@ar.usda.gov 
or Dave Moffit at (817) 509-3315/ dmoffitt@ftw.nrcs.usda.gov. 
 

 
Future Enhancements 
USDA-NRCS solicits the input of users to help determine the priority of potential 
enhancements to AWM.  Please contact user support to let us know what enhancements 
would be of value to you. 

mailto:bwilson@wcc.nrcs.usda.gov
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Chapter 2 – Installing and 
Starting AWM 

 
What You Need to Use AWM 
System requirements: 

 Any IBM-compatible machine with at least a 400 Mhz processor. 
 Microsoft Windows 2000/XP 
 Microsoft Access 2002 
 At least 128 megabytes of memory 
 At least 100 megabytes of hard drive storage space 

 
Installation on CCE and Non-CCE Machines 
AWM may be installed on both USDA Common Computing Environment (CCE) machines 
and non-CCE machines.  The AWM installation program will detect whether your machine is 
a CCE machine and make necessary adjustments to the installation process.  System 
administrator privileges will be needed to install AWM. 

 
Installing AWM 
AWM is available from the NRCS National Water and Climate Center 

1. Download the following files from the USDA-NRCS National Water and Climate 
Center, Animal Waste Management webpage: 
www.wcc.nrcs.usda.gov/awm/awm.html  to a temporary directory on your 
computer’s hard drive: 

 The AWM installation program, . 
 The AWM database file,  where # is the version number. 
 AWM User Guide in MS Word (doc) or  Portable Document Format (PDF). 

Note: The installation files for the AWM computer program are fairly large so unless 
you are connected to a high speed internet connection it strongly recommended that 
you request the program be sent to you on CD. Please submit your request to Bruce 
Wilson by phone at (503) 414-3076 or by email at bwilson@wcc.nrcs.usda.gov. 

2. Execute the installation program by either: 
 Double clicking on  in Windows Explorer, or 
 Clicking Start, select Run, browse to the location of the installation file, select 

, and click the  button.  
Note: You must have system administrator privileges to install AWM. 

3. After installing AWM be sure to follow the instructions on the next page to install the 
current database so the most up-to-date information is used in the program. 

http://www.wcc.nrcs.usda.gov/awm/awm.html
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Installing the AWM Database 
When AWM is installed it also installs a database containing animal, bedding, climate, and 
separator data for each state.  The most up-to-date database is located on the AWM website 
and should be downloaded and installed to ensure the most up-to-date data will be used in 
developing designs. To download the most current database for AWM, click on Help-
>Contents in the AWM main menu as shown below: 

 
The following popup window will appear: 

 
Click on "AWM Database" in the Contents window to access the AWM database download 
site as shown above.  Click on AWM Database link to download the most current version of 
the AWM database.  After downloading the database perform the following steps to install 
the database file for use with the AWM program: 

1. Execute the self extracting WinZip database file by either: 
 Double clicking on  in Windows Explorer, or 
 Clicking Start, select Run, browse to the file location, select , 

and click the  button.  

2. The follow popup screen will appear that explains what version of the database is 
being installed and the changes it contains: 

. 
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3. Click on the  button to continue installing the database. The following 
popup screen will appear: 

 
4. Click on the  button to install the database in the default AWM program 

directory. The following popup screen will appear: 

 
 

5. Click on the  button to continue.  The following popup screen appears: 

 
6. Click on the  button to finish.  The database is now ready to be used with 

the program. 
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Starting AWM 
The following instructions explain a few of the ways to start the AWM program: 

 
Any Computer 

AWM may be started by clicking on     

   .  This will open the 
program without opening any saved client files. 
 

From Windows Explorer 
A previously saved design file may be used to open AWM.  From within Windows 
Explorer, locate and double-click on a previously saved design file.  These files will have 
the extension awm (e.g., Elmer_Farms.awm) 
 

From the Customer Service Toolkit Client List 
Within the USDA Customer Service Toolkit you can browse the client list in Outlook and 
determine if the client files include any AWM design files.  These will be identifiable by 
the .awm extension.  Clicking on these files will open AWM with the previously saved 
design file. 
 

From the Customer Service Toolkit  
Anytime you are working within Customer Service Toolkit on a client you may click on 
Tools in the menu bar, click on Engineering Tools, and select AWM.  AWM will open 
with the client’s name automatically entered.  Upon exiting AWM the file will be saved 
with the files for that client.   
 

Quitting AWM 
 

From the file menu click on File then Exit, 

 
or press the [Alt] [F] [X] keys on the computer keyboard, 
or click on the  in the upper right-hand corner to exit AWM.   
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• The previous action results in the following popup screen: 

. 

Press the [Enter] key to 
select  or click 
on the appropriate 
button. 





 

AWM User Guide  Page 7 

 
  

Chapter 3 – Navigating  
Within AWM 

Overview 
The process of designing treatment/storage facilities using AWM involves a step-by-step 
sequence of screens.  When developing an initial design, the sequence of screens in the order 
shown on the toolbar must be followed with the exception of the calculator that can be used 
within any of the screens.   

 
The screens and their function are as follows: 

 
Start -  On this screen the user defines the client, defines the designer, selects the 
data source (NRCS, MWPS, etc.), and sets up the operating period(s). 

 
Climate -  On this screen the user defines the monthly climate parameters, the 25-
year, 24-hour precipitation, and other climate-related factors. 

 
Animals -  On this screen the user selects animal types and enters the number and 
average weights.  Animal characteristics may be modified and new animal types 
can be defined within this screen. 

 
Locations -  On this screen the user defines locations where wastes are generated.  
Wastes from different locations may have different additions to the waste stream 
and the wastes may be routed through different management trains. 

 
Additions -  On this screen the user defines any additions to the waste streams 
such as from bedding, waste water, and flush water.   

 
Runoff -  On this screen the user may elect to allow AWM to calculate runoff 
volumes or to enter volumes calculated outside the program. 

 
Management Train -  On this screen the user selects a sequence of 
treatment/storage components for each waste stream. 

 
Design -  On this screen the user specifies the parameters used to size and 
calculate the dimensions of treatment/storage components.  A monthly waste 
stream budget is displayed on this screen. 

 
Calculator -  This is a popup screen that can be used within any of the  design 
screens to calculate unit conversions and perform other calculations.  The 
calculator is not available within the ramp design screen.  The calculator must be 
selected from a separate button within the soil liner design screen. 

 
Manure Master -  On this screen the user can generate a gross nutrient budget by 
selecting crops and entering acres and yield data. 
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Moving Between Screens 
During the initial entry of information the user is moved from screen to screen in 
sequence by clicking on the  button on each screen. 
 
At any time the user may move to a previously completed screen by clicking on the large 
navigation buttons; 

 
When a screen has been completed and the user clicks the  button, the next 
navigation button will change from gray to colored.   
 
When a navigation button is in color; 

 
 it may be used to move immediately to that screen by clicking on the associated button.   
 
The popup calculator screen is available in any screen so it is always in color. 
 
Any changes to information on a screen will immediately modify values on later screens 
if the change affects calculated values. 

 
HELP 
Help messages providing information on data entry and the operation of AWM can be 
accessed from the main menu or by pressing the [F1] key on the keyboard. 

 

 

 
 

Click on  
and then either 
click on  

 

AWM User Guide 
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Clicking on  or the [F1] key reveals the following menu. 
Click on window topic (book) on which help 
information is needed. 

 

Help can also be accessed on each screen by clicking on the  button or pressing the 
[F1] key on the keyboard.  Help accessed in this manner gives information about the current 
screen. 

 

Click on the 

button.
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Entering Data into AWM  
 
The following provides general guidance on how to enter data into the input fields used in 
AWM screens: 

1. Clicking on an input cell within a screen activates the edit mode.  The edit mode is 
indicated by the cursor blinking at the end of any value or by the text that is already in 
the cell. 

2. Double clicking on an input cell within a screen activates the edit mode and 
highlights the data in the cell so that it can be replaced. 

3. Using the arrow keys will exit the edit mode and move the focus rectangle to a new 
input cell. 

4. Typing any value or text in an input cell that is not in edit mode (cursor is not 
blinking and is highlighted with the focus rectangle) replaces whatever data is in the 
cell. 

5. Pressing [Enter] in an input cell causes the focus rectangle to move to the next input 
cell while remaining in the edit mode. 

 
Using the above guidance for entering data into AWM input fields is demonstrated with the 
following example of changing the precipitation and evaporation values in the AWM Climate 
Screen. 

1. Start AWM, select a state and then press the  button on the Start screen, 

 

Select a State. 

Click on the 

 button. 
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2. Click in the January precipitation cell.  This action activates the edit mode, and the 
cursor will be blinking after the value to be edited: 

 

Click on January 
Prec input cell. 

3. Highlight the value with the cursor and mouse or clear the cell by backspacing and 
then type in a new value followed by pressing [Enter].  This exits the edit mode and 
moves the focus rectangle to the February precipitation input cell.   

4. Pressing [Enter] in step 3 above allows one of two actions to be taken in the February 
precipitation input cell:   
a.) Type in a new value replacing whatever value is in the cell or, 
b.) Press the backspace key to activate the edit mode indicated by the cursor blinking 

at the end of the value or text.  This allows the value in the cell to be highlighted 
with the mouse or use the backspace to delete the data and then type in a new 
value. 

5. Press [Enter] to go to the next cell.   

6. Steps 4 and 5 can be repeated for each cell that requires editing. 

See note next page. 
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Note:  An input cell is shaded red when the value in the cell is outside the range of 
reasonable values stored in the database.  The values stored in the database can be 
edited by accessing the Tools -> Options menu.  Cells shaded red is just a warning to 
the user that the data is outside the normal range and the data will still be used by the 
program for calculations.  
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Chapter 4 – Running AWM 
 
Start Screen 

 
AWM may be started in a number of manners as explained in Chapter 2.  When AWM is 
opened without a specific design file it will open with the following screen. 
 

`  
 
 



Start Screen 
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The illustration below shows the “New” tab selected.  This is also the default setting. 

 

Type in your name. 

Type in landowner’s 
name. 

“New” tab selected. 

Click here to access 
the Data Source 
drop-down list and 
then select the 
preferred animal data 
source.  

 



Start Screen 
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Click on the 

button if the farm 
has more than one 
operating period. 

Click here to select 
a state. 

 
Operating Periods 
 
AWM has two options for defining operating periods. The screen shown on the next page 

will appear when the  button is clicked on.  Click on the radio 
button   for 1 operating period when the facility is operated the entire year 
without variation.  For example this option would be selected for a dairy where animals are 
in confinement for the entire year.  Click on the radio button  for 2 
operating periods when a facility operates in two distinct periods.  An example of when this 
option would be selected is for a dairy that keeps its animals in confinement for a part of the 
year and pastures the remainder. 



Start Screen 
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If “2 Operating Periods” are selected, the beginning and ending 
month for the first operating period must be selected.  Once this 
period is selected, AWM uses the remaining months for the second 
period.  The operating period is from the first day of the beginning 
month to the last day of the ending month. 
 
Monthly precipitation and runoff for the entire year is used in the 
design of waste treatment/storage facilities regardless of the operating period. 

“2 Operating 
Periods” are 
selected. 
 
Click here to 
access the 
Beginning Month 
drop-down list and 
click on the 
beginning month of 
first operating 
period. 
 
Click here to 
access the Ending 
Month drop-down 
list and click on the 
ending month of 
first operating 
period. 

 
To continue work on a previously saved job/design, select either the “Existing” or “Recent” 
tab.  Selecting the “Recent” tab will show the last ten jobs saved.  Selecting the “Existing” 
tab will show all the previously saved jobs in a particular directory. 



Start Screen 
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Select “Existing” tab 
for a list of all 
previously saved jobs.
 
Click on the desired 
file and click the 

 button to 
load the stored data 
into the AWM program 
from the selected file. 

 

Select “Recent” tab 
for a list of the last 10 
jobs that were loaded 
when the user exited 
AWM. 
 
Click on the desired 
file and click the 

 button to 
load the stored data 
into the AWM program 
from the selected file. 



Climate Screen 
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The climate screen allows the user to define the monthly precipitation and evaporation, the 
25 year – 24 hour precipitation, and the anaerobic lagoon volatile solids loading rates.  There 
are two options for defining the climate data used within AWM.  One is to use the AWM 
database, which is the default option shown below, and the other is to enter custom climate 
data for the job.  Any input cell shaded red means the data it contains is outside the range of 
values stored in the data validation database.  The values in the data validation database 
define the range of expected values for an entry as a check for the user.  The values in the 
data validation database can be edited in the Tools -> Options menu. 

 



Climate Screen 
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Climate data populating the screen when the  option is selected is based 
on the County and Station selected from the drop-down lists.  The monthly precipitation, 
monthly evaporation, 25-year, 24-hour precipitation, and the lagoon loading rate may all be 
edited by clicking on the associate input cell for the data to be changed.  Changes made in 
this manner will only be in effect and saved for the current job.  Permanent changes can be 
made by clicking on Data > Edit Climate Data on the AWM main menu as shown below.  
For more on editing, see Chapter 6, “Modifying the AWM Database.”  
 

 

Click on “Edit Climate Data” 

  
All of the climate data populating the climate screen is cleared, as shown below, when the 

 option is selected.  With this option the user completes all 
data fields manually.  The data entered in this manner will be saved with the current job and 
is not available for future jobs. To have climate data available for future jobs it is necessary 
to modify the AWM database.  Permanent changes to the climate database can be made by 
clicking on Data > Edit Climate Data on the AWM main menu as shown above.  For more on 
editing, see Chapter 6, “Modifying the AWM Database.” 
 



Climate Screen 
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AWM has three options for accounting for precipitation and evaporation in the design of 
waste treatment/storage facilities. 
 

 
 

 
Select this option to consider evaporation only to the extent it does not exceed precipitation.  
For the example shown on the previous page, AWM would set precipitation minus 
evaporation to 0 inches for the month of July.   
 

 
Select this option to consider evaporation even when it will cause a deficit value for 
precipitation minus evaporation.  For the example shown on the previous page, AWM would 
set the value of precipitation minus evaporation to –4.7 inches for the month of July. 
 

 
Select this option when evaporation should be ignored.  For the example shown on the 
previous page, AWM would set the value of precipitation minus evaporation to be 0.7 inches 
for the month of July.  This may an appropriate option for waste storage facilities and 
anaerobic lagoons where a crust will form that may impede evaporation. 



Animals Screen 
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The following Animals screen appears when a new design file is being created within AWM 
so a user can select animal types and descriptions from the data file source selected on start 
screen.  AWM allows the user to select mixed animal types and descriptions. 

 

1. Click on the drop-
down list to select 
the animal type. 

3. The animals 
selected are shown 
in the selected list 
window. 

2. Click on the animal description in 
the choices list window and click 
the add button to select the 
highlighted choice. 

Click the  
button to remove 
highlighted animals 
from the selected list 
window.  

Click the 
button to remove all 
animals from the 
selected list window. 

Click the  
button to add all 
animal choices in the 
choices list window. 

Click the  
button when done. 

 



Animals Screen 
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The following screen shows the Animals screen populated with an
AWM MWPS data file.    

Enter the quantity and average weight 
in pounds for each animal selected. 

If another animal type is needed but not shown in the AWM datab

 button that will result in the popup screen show

 

.

 

imals selected from the 
Animals may be added at any
time by clicking on the 

 Button. 
 
ase, click on the 

n below. 

 

Enter the name of the animal 
type being added 
Click on the drop-down list to 
select the animal type being 
added. 
Enter the manure volume, 
volatile solids, total solids, 
sludge accumulation ratio, 
and flush water as 
appropriate. 
Enter the pounds per ton of 
Nitrogen, Phosphorous, and 
Potassium that will be 
generated by the animal being
added after all losses are 
accounted for.  
Click on this box if animal 
type involves lactating cows.  
This associates the new 
animal with a flush water 
volume per animal. 
AWM User Guide 
 
Click the  
button when done



Animals Screen 
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A row may be deleted from the Animals screen by selecting the row and clicking on the 

 as shown on the screen below. 

 

2. Click on the  
button or press the [Delete] 
key on the keyboard to delete 
the selected row. 

1. Click on the animal cell to 
select the row to be deleted. 

 
The Quantity, Weight, Manure, VS, and TS may be edited by clicking on the input cell and 
typing in the desired value as shown on the screen below.   

 

For any of the selected animals, click on 
the desired input cell to edit the 
displayed data. 



Animals Screen 
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The values for an animal type appearing on the Animals screen may also be edited by double 
clicking on the animal type as shown on the screen below. 

 

 

Revise values in 
resulting popup 
screen as 
necessary. 

Double click on 
animal. 

 
Changes made by editing data within the Animals screen will only apply to the current job 
and is not available for future jobs. To have animal data available for future jobs it is 
necessary to modify the AWM database.  Permanent changes can be made by clicking on 
Data > Edit Animal Data on the AWM main menu as shown below.  For more on editing, see 
Chapter 6, “Modifying the AWM Database”. 

 
 



Animals Screen 
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Click the  button when done 
editing the Animals Screen. 



Locations Screen 
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The purpose of the Locations screen is to define where the animals deposit their manure 
throughout a day for each operating period.  It also establishes a manure waste stream from a 
location to which waste water, flush water, and bedding are added to form the total waste 
stream directed to agricultural waste management system treatment/storage components such 
as a waste storage facility or waste treatment lagoon.    

 

Type in the name of a 
location where 
animals spend time. 
After typing in the name 
of the location, click the 

 button
or press the [Enter] key. 
AWM User Guide 

 



Locations Screen 
 

 

AWM User Guide  Page 27 

Once all the locations have been entered, the percent of manure deposited by each animal 
type in each location must be entered as shown on the screen below.  Please note this is the 
percent of manure and not the percent of time.  Judgement based on observation will be 
required for making this determination because it varies widely.  The percent manure must 
total 100 percent for each animal type. If two operating periods were selected on the start 
screen, a location table will be presented for each operating period. 

 

Enter the percent 
of manure each 
animal type 
deposits in each 
location. 
 
 

To delete a location first select the row by clicking on the narrow cell just to the left of the 
location as shown on the screen below.  This highlights the row.  Now click on the 

 button.  Rows can only be selected and deleted from the first operating 
period table if more than one operating period was selected on the Start screen.  This action 
deletes the location from the table for both operating periods. 

To delete a row, 
click here to 
highlight the row, 
and then click on 

 
button or press 
the [Delete] key on 
the keyboard.   

 

Click the  
button when done 
editing the 
Locations screen. 



Additions Screen 
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The purpose of this screen is to characterize the amount of flush water, wastewater, and 
bedding added to the manure waste stream for each of the locations identified on the 
Locations screen. 
 
To add additional locations where waste is generated, enter the name of the location and click  

on the  button as shown on the screen below. 
 
 
 
 
 

 

Type in the name of additional waste 
streams.  These will appear in the table in 

italics after clicking on the  button. 

The additional waste 
stream entered is 
shown in italics. 

 
 
 
The total wash water and flush water in gallons r by using 
the pop-up calculator.  The pop-up calculator s  button 
next to the Wash Water or Flush Water input c
Click on the  button to 
access the Wash Water and
Flush Water calculator 

 per day may be entered directly o
creen is selected by pressing the 
AWM User Guide 

ell as shown on the screen above. 



creen 
 

p screen for wash water follows: 
Enter the amount that 
applies to the operation 
in gallons per unit that is 
appropriate for each 
Source or Hose. 

Type in the washes or 
minutes per day for 
each operation where 
an amount was entered 
for a Source or Hose. 

 

 
 
 

Additions S
 
The calculator pop-u

Location that 
wash water is 
being calculated
for. 
AWM User Guide  

 

Checking this box means the last 
data entering into the Wash Water 
screen will be saved and displayed 
the next time the screen is accessed. 

 
Click the  button
when done editing the 
Wash Water screen. 
Page 29 



Additions Screen 
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The calculator pop-up screen for flush water follows: 
Enter the amount of 
flush water used for 
each animal in gallons 
per head(animal). 

Location that flush 
water is being 
calculated for. 

 
Checking this box means the last 
data entering into the Flush Water 
screen will be saved and displayed 
the next time the screen is accessed. 

Take care to indicate a flush volume for only those animals id e 
location on the Locations screen.  Also please note that if recy , 
values entered should only be to the extent that fresh non-recy
system. 
 
Clicking on the  check box will save the data in th
calculator for the current design session of AWM. All values 
and Flush Water calculator will be lost once the AWM design
 

Click the  button
when done editing the 
Flush Water screen. 

entified as spending time at th
cled water is used for flushing
cled water is added to the 
AWM User Guide 

e Wash Water and Flush Water 
entered into the Wash Water 
 session is closed. 



Additions Screen 
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On the Additions screen shown below be te strea
amount per day added at each location in ding is
the amount used should be converted to e ay. 

Click here to access 
drop-down list of 
bedding, then click on 
bedding type used. 

 

Bedding volumes computed by the AWM
bedding densities stored in the AWM dat
permanently changed by clicking on Data
shown below.  For more on editing, see C
 
dding is added to a was
 pounds per day.  If bed
quivalent pounds per d
Type in amount of
bedding added in 
terms of pounds 
per day. 
 

 

 
 program will be dep

abase.  Bedding dens
 > Edit Bedding Dat  as 
hapter 6, “Modifyin
Click the  
button when done 
editing the Additions
endent on the effective 
ities can be viewed and 
a on the AWM main menu
g the AWM Database”. 
m by indicating the 
 not added every day, 

The amount of bedding in 
cubic feet per day is 
automatically displayed 
based on the density stored 
in the bedding database. 
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The Runoff screen estimates the contaminated runoff that must be managed by the waste 
management system.  Runoff volumes estimated by AWM are conservative overestimates.  
Because of this, the user is encouraged to use a method outside the program to determine the 
monthly and the 25-year, 24-hour runoff volumes, especially when larger watersheds are 
involved. 
 
AWM computes runoff for two types of “watersheds:” 

 impervious “watersheds” such as roofs and frequently scraped concrete slabs; and 
 pervious watersheds including feedlots with a manure pack.. 

 
The runoff volume from only one drainage area for each type of watershed is computed.  If a 
system design requires evaluation of more than one drainage area in one or both types of 
watersheds, the runoff volumes will need to be computed outside the program and entered as 
demonstrated below. 
 
Impervious watershed runoff is computed based on a Curve Number of 98 and a user input 
impervious area in square feet.  AWM does not allow the Curve Number for this watershed 
type to be changed.  If a different Curve Number is desired, the AWM computation should be 
made using the pervious watershed category or by using a method outside the program. 
 
Pervious watershed runoff is computed on the basis of a user-input Curve Number and 
watershed area in acres.  Feedlots having a manure pack should use this method.  The user 
can enter a 1 day curve number and click the  (1-day) radio button and the program will 
convert the 1 day curve entered to a 30 day curve number. The 30 day curve number 
computed from the 1 day curve number may be viewed by passing the mouse pointer over 
the  (1-day) radio button.  If the user enters a 30 day curve number and clicks on the  
(30-day) radio button, the program will use the curve number as entered to compute the 
runoff volumes. 
 
AWM computes runoff by first converting the 1-day Curve Number to a 30-day Curve 
Number using the following equation: 

CN30 = CN1 – (CN1 – ((CN1^2.365)/631.79)  -  15) log 30 

The equations of the EFH Handbook Chapter 2 revised for a 30 day CN would be: 

S = (1000 / CN30) – 10                  (Rearranged Equation 2-4) 

Q = ((P – 0.2S)^2 / (P + 0.8S))       (Equation 2-3) 

Where:      Q = runoff in inches 
             P = rainfall in inches 
             S = potential maximum retention after runoff begins in inches 
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The following illustrates the Runoff screen when 
button is selected. 

 
Click on the  
radio button. 

 
T  volumes based on the pre
c e screen. 

 

Ente
wate
 

 radio 
Type in the pervious 
watershed area and the 1-
day runoff curve number for
the 25Yr-24Hr storm rainfall 
and the 1-day or 30-day 
runoff curve number. 
 

cipitation data and runoff 

r the impervious 
rshed area. 
he program will compute the runoff
urve numbers entered on the Climat

If a one day curve number is 
selected, passing the mouse 
over the  (1-day) will display
the 30 day curve number. 
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Runoff volumes based on calculations made outside the program may be entered directly into 
the runoff table.  To enter runoff volumes directly, select the   
button as shown below. 

 

Enter monthly runoff as 
determined by a method 
outside AWM. 

Click on the  
radio button. 

Click the  
button when done 
editing the Runoff 

Enter 25-year, 24-hour storm 
volume as determined by a 
method outside AWM  

 



Management Train Screen
 

 
The purpose of the Management Train screen is to define the sequence of management 
components, as described within AWM, for each waste stream developed by the program in 
the Locations and Additions screens.  The sequence of components is described in AWM as 
management “steps.”  AWM is capable of evaluating up to three management steps or 
components for each waste stream.  Solid-liquid separator components split a waste stream 
into two waste streams – solids and liquids.  Each of these new waste streams must be 
followed by appropriate storage components.  An uncovered stacking facility requires a 
liquid storage component, either a pond or a tank, be specified in the next step to store runoff.  
An anaerobic lagoon with external storage requires that a liquid storage component, either a 
pond or a tank, be specified in the next step.  Multiple waste streams may be directed to a 
single management component 
 
The following is a blank Management Train screen for a dairy as it would appear when 

gement system design.  The waste stream column lists the 
fined on the Locations screen, (2) any user-defined waste 
n an input cell will access a drop-down list of available 
een below. 

Click on desired component for 
Step 1 of the waste stream 
management stream. 

 

 
A
c

AWM is run for a new waste mana
waste streams from (1) locations de
streams, and (3) runoff.  Clicking o
components as illustrated on the scr

Click within the input cell to 
access the drop-down list of
available components. 
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 storage pond, storage tank, covered dry stack, or anaerobic lagoon can be a terminal 
omponent in the waste management train.  However, a solid-liquid separator, uncovered dry 



Management Train Screen 
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stack, and anaerobic lagoon with external storage all require an appropriate subsequent liquid 
storage component. 
 
The first time the component drop-down list is accessed, all of the available components will 
be identified as “new”.  Once a component is selected for a management step, it will appear 
on subsequent drop-down lists and is available for use in other waste stream management 
steps.  For example, if “New Storage Pond” is selected for one management step, the next 
time the drop-down list is accessed this pond will appear as “Storage Pond #1”.  This pond 
could then be selected for another waste stream.  However, if a second storage pond is 
desired, “New Storage Pond” would be selected.  Subsequent access to drop-down list would 
identify this pond as “Storage Pond #2.” 
 
When the “Solid-Liquid Separator” component is selected, another drop-down list is 
accessed that gives a list of separator types. 

 

Select solid-liquid 
separator.  

Select type of  
separator.  

 



Management Train Screen
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The next step after solid-liquid separation must define the components to which both the 
solids and liquids will be directed as shown below. 
 

 

Clicking in the input cell for Step 2, for the example 
shown below, accesses the drop-down list of 
components that can be selected as a treatment/storage 
component for both liquids and solids. 

When an uncovered dry stack is selected, an appropriate liquid storage component must be 
selected in the next step to store its runoff as shown on the screen below. 

 

Clicking in the input cell for Step 3, for the example shown below, 
accesses a drop-down list of components that can be selected to 
store runoff from the uncovered dry stack’s facility. 

When an anaerobic lagoon with external storage is selected in the management train, it must 
be followed in the next step with an external storage component as illustrated below: 



Management Train Screen 
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Clicking in the input cell for Step 3, in the example shown 
on the screen below, accesses a drop-down list of storage 
components that can be selected to store effluent from the 
anaerobic lagoon. 

 

 

 

Click the  
button when done 
editing the 
Management Train
AWM User Guide 
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The Design screen will reveal tabs for each of the storage or treatment facility components, 
except solid-liquid separation facilities, that were selected on the Management Train screen 
as shown below.   

 

Click on a Tab for the component to 
access the design screen. 

 
 
 



Design Screen 
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Dry Stack Design (Covered and Uncovered) 
 
The AWM design of dry stacks is the same for both uncovered and covered stacks with the 
exception that the precipitation falling on an uncovered dry stack is directed to a waste 
storage pond or tank. Therefore, from a sizing standpoint, both covered and uncovered design 
screens are the same.  Even though the design screen for a covered dry stack is illustrated, it 
applies to uncovered as well. 
 
The following screen illustrates a design based on inputting the bottom width, depth and 
defining the withdrawal months: 

AWM computed 
dimensions for the 
example shown 
below. 

 Vary depth and bottom 
width to accommodate 
the site and available 
standard plans. 

 
 

selected for the example 
shown above. 
Click on drop-down list to
select  or 

 to base 
design on.
M User Guide 

 

 AW

Click on box to check or uncheck 
months when withdrawal is 
planned.  Withdrawal is on the last 
day of the month checked. 
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The following screen illustrates a design based on inputting the bottom width, depth and 
defining the storage period: 
 Vary depth and bottom 

width to accommodate 
the site and available 
standard plans. 

AWM computed 
dimensions for the 
example shown. 

 selected fo
shown.  Use the storage peri
list to select the number of m
the storage period. 

 

Click on drop-down list to 
select  or 

 dimension 
to base design on.
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r the example 
od drop-down 
onths to use as 



D
 

 

Pa

T tes the set wall height design option for dry stack facilities: 

Vary wall height, storage 
depth and side slope to 
desired dimensions. 
esign Screen 

he following screen illustra

Click on  
check box to access 
the set wall height 
design screen. 
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Setting the wall height 
to zero allows a dry 
stack slab to be 
designed. 

 
Click the  
button when done the 
design screens. 

If a one month storage period is 
selected, the program allows the user 
to select less than thirty one days for 
the storage period. 



Design Screen 
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Storage Pond Design  
 
The design of storage ponds in AWM allows the user to define a rectangular or circle type 
pond. AWM bases the design on the storage depth, bottom width or length, permanent 
additional storage, freeboard, sideslope ratio and maximum storage volume method inputs 
made by the user. 
 
The following screen illustrates a rectangular storage pond design based on defining 
withdrawal months: 

 

 

Click on drop-down 
list to select the 
shape of the pond to 
base design on. 

Click on drop-down list to 
select   or 

 dimension 
to base design on. 

Vary depth and 
bottom length to 
accommodate the 
site. 

 
 

Click on box to check or 
uncheck months when 
withdrawal is planned.  
Withdrawal is on the last 
day of the month checked. 

AWM computed 
dimensions for 
the example 
shown. 

 
selected for the example 
shown.   
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For a storage pond design is based on a storage period or withdrawal months, AWM 
determines which set of consecutive months during the year requires the greatest storage 
volume and sizes the facility accordingly. 
 
The following screen illustrates a circular storage pond design based on defining a storage 
period: 

Vary depth to 
accommodate 
the site. 

 
 
 
 

Storage depth is the total depth of the 
precipitation, depth of 25-yr., 24-hr. s
evaporation option selected on the Cli
required to meet management goals o
313, Waste Storage Facility). 

AWM computed 
dimensions for 
the example 
shown. 

 option 
selected for the example 
shown.   

Click on drop-down list to 
select shape of the pond to 
base the design on. 
Click on drop-down list 
to access a list of 
months(1-12) to select a 
storage period from.
 Page 45 

pond less freeboard, depth of 25-yr., 24-hr. 
torm event runoff, and depth of precipitation less 
mate screen.  Permanent additional Storage may be 
r regulatory requirements (see NRCS Practice Standard 



een 
 

n illustrates the soil liner design option for a storage pond: 
Enter the permeability of the soil 
to be used for the liner.  This 
value is normally available from 
the soil mechanics report. 

 
Enter the allowable specific 
discharge.  This value may 
be based on regulatory 
requirements. 
Design Scr

 

The following scree
Click on 

 to
access the soil 
liner design 
screen. 
Page 46 

 

 
 
 

 

The liquid depth AWM uses for d h of the 
pond less freeboard, depth of 25-y yr., 24-hr. 
storm event runoff.  
 

Click on to access the conversion
calculator.   The calculator can be 
used to convert centimeters per 
second to feet per day.  See the 
Calculator section in this chapter for 
more information.

esigning the soil liner is based on the total dept
r., 24-hr. precipitation, and the depth of the 25-
 AWM User Guide 
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The following screen illustrates the parallel ramp design option for a storage pond: 

 

Enter the preferred 
slope ratio and 
width of the ramp. 

Click on the drop-down list to 
select the type of ramp to 
design.  Choices are Parallel 
and Perpendicular. 

Click on 
 to 

access the ramp 
design screen. 

AWM computes the length of 
the ramp and shows the 
dimensions of the ramp on 
the schematic drawing of the 
storage pond. 

Note: The parallel ramp design screen is not available for circular ponds. 
 



Design Screen 
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The following screen illustrates the perpendicular ramp design option for a storage pond: 

 

Enter the preferred 
slope ratio and 
width of the ramp. 

Click on the drop-down list to 
select the type of ramp to 
design.  Choices are Parallel 
and Perpendicular. 

AWM computes the length of 
the ramp and shows the 
dimensions of the ramp on 
the schematic drawing of the 
storage pond. 

Click on 
 to 

access the ramp 
design screen. 

Note: The perpendicular ramp design screen is not available for circular ponds.



Design Screen 
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Click on  button to 
access the stage storage curve for 
the storage pond design. 



Design Screen 
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The following screen illustrates the stage storage curve for the example storage pond design: 

 



Design Screen 
 

 
Storage Tank Design 
 
The design of tanks in AWM allows the user to define a rectangular or circular type tank. 
AWM bases the design on the storage depth, bottom width or length, permanent additional 
storage, freeboard, precipitation excluded or not and maximum storage volume method 
inputs made by the user. 
 
The following screen illustrates a rectangular tank design based on defining withdrawal 
months: 

 

Click on drop-
down list to 
select shape of 
the tank to base 
the design on. Vary depth and width as needed 

to fit tank to site conditions 

Click on drop-down list to select 
 or  

dimension to base design on. 

 
Click on the  

 check 
box if tank is covered to
exclude precipitation. 
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and/or standard drawing. 

 
option selected for the 
example shown.   

AWM computed 
dimensions for 
the example 
shown. 

 

Click on box to check or 
uncheck months when 
withdrawal is planned.  
Withdrawal is on the last 
day of the month checked. M User Guide 
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For a tank design based on a storage period, AWM determines which set of consecutive 
months during the year for the storage period specified requires the greatest storage volume 
and sizes the facility accordingly. 
 
The following screen illustrates a circular tank design based on defining a storage period and 
excluding precipitation: 

 

 Vary depth to 
accommodate the 
site conditions. 

Click on drop-down list to 
select shape of the tank to 
base the design on. 

Storage depth for covered tanks exclu cipitation and depth of 
precipitation less evaporation option s .  Permanent additional 
Storage may be required to meet mana quirements (see NRCS 

Dimensions 
computed by 
AWM for the 
example shown.

 
option selected for 
the example shown.   
des depth of 25-yr., 24-hr. pre
elected on the Climate screen
gement goals or regulatory re

Click on drop-down list 
to access a list of 
months(1-12) to select a 
storage period.
Click on  
if tank is covered with a 
lid or roof to exclude 
precipitation. 
 AWM User Guide 
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Practice Standard 313, Waste Storage Facility).  Passing the mouse pointer over  
will generate a popup box that shows the cubic feet of storage associated with the depth of 
additional storage entered. 

The following screen illustrates the parallel ramp design option for a rectangular tank: 

 

Enter the preferred 
slope ratio and 
width of the ramp. 

Click on the drop-down list to 
select the type of ramp to 
design.  Choices are Parallel 
and Perpendicular. 

AWM computes the length of 
the ramp and shows the 
dimensions of the ramp on 
the schematic drawing of the 
rectangular tank. 

Click on 
 to 

access the ramp 
design screen. 

The parallel ramp design screen is not available for circular tanks. 
 



Design Screen 
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The following screen illustrates the perpendicular ramp design option for a rectangular tank: 

 

Enter the preferred 
slope ratio and 
width of the ramp. 

Click on the drop-down list to 
select the type of ramp to 
design.  Choices are Parallel 
and Perpendicular. 

AWM computes the length of 
the ramp and shows the 
dimensions of the ramp on 
the schematic drawing of the 
rectangular tank. 

Click on 
 to 

access the ramp 
design screen. 

The perpendicular ramp design screen is not available for circular tanks. 
 
 
 



Design Screen 
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Anaerobic Lagoon Design  
 

The inputs for the design of anaerobic lagoons in AWM are very similar to the design of a 
storage pond.  AWM allows the user to define a rectangular or oval type lagoon. AWM bases 
the design on the storage depth, bottom width or length, permanent additional storage, 
freeboard, sideslope ratio, sludge accumulation period and maximum storage volume method 
inputs made by the user. 

The following screen illustrates a rectangular anaerobic lagoon design based on defining 
withdrawal months: 

M User Guide  

 
AWM computed 
dimensions for 
the example 
shown. 

Click on drop-down 
list to select 

 or 
 

dimension to base 
design on. 

Click on drop-down 
list to select the 
shape of the lagoon 
to base design on. 
Choices are 
rectangular and 
circular. 

The NRCS 
design 
methodology is 
used unless the 

is checked. 

Vary depth and 
bottom width to 
accommodate 
the site. 

 
  
selected for the example 
shown.   

Click on box to check or 
uncheck months when 
withdrawal is planned.  
Withdrawal is on the last 
day of the month checked. 



Design Screen 
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For an anaerobic lagoon design based on a storage period, AWM determines which set of 
consecutive months during the year for the storage period specified requires the greatest 
storage volume and sizes the facility accordingly. 
 
The following screen illustrates a circular anaerobic lagoon design based on defining a 
storage period and using the Rational Design Method: 

 

Click on drop-down list to 
select shape of the lagoon 
to base the design on.  
Choices are Rectangular 
and Circular. 

The NRCS 
design 
methodology is 
used unless the 

is checked. 

Vary depth to 
accommodate 
the site. 

AWM computed 
dimensions for 
the example 
shown. 

 
option selected for the 
example shown.   

Permanent additional Storage may be  goals or regulatory 
requirements (see NRCS Practice Stan agoon).  At least 1 year 
of sludge accumulation period should ge buildup in the lagoon.
 

Click on drop-down list 
to access a list of 
months(1-12) to select a 
storage period.

 required to meet management
dard 359, Waste Treatment L

 be entered to account for slud
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The following screen illustrates the soil liner design option for an anaerobic lagoon: 

 

 
 
 

Click on  to access the conversion 
calculator.   The calculator can be 
used to convert centimeters per 
second to feet per day.  See the 
Calculator section in this chapter for 
more information. 

Enter the permeability of the soil 
to be used for the liner.  This 
value is normally available from 
the soil mechanics report. 

Click on 
 

to access the 
soil liner design 
screen. 

Enter the allowable specific 
discharge.  This value may 
be based on regulatory 
requirements. 

The liquid depth AWM uses for designing the soil liner is based on the total depth of the 
lagoon less freeboard, depth of 25-yr., 24-hr. precipitation, and the depth of the 25-yr., 24-hr. 
storm event runoff.  
 



Design Screen 
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Click on 

button to access 
the stage storage 
curve for the 
anaerobic lagoon 
design. 



Design Screen 
 

 

AWM User Guide  Page 59 

The following screen illustrates the stage storage curve for the example anaerobic lagoon 
design: 

 



Design Screen 
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Anaerobic Lagoon with External Storage  
 
The anaerobic lagoon with external storage design option utilizes an anaerobic lagoon to 
contain the minimum treatment volume.  All other volume requirements are contained in the 
storage facility that must follow the lagoon in the management train.  The only time this 
lagoon would be emptied would be for sludge removal. 

The following screen illustrates a rectangular anaerobic lagoon with external storage design: 

AW

 

Click on drop-down 
list to select the 
shape of the lagoon 
to base design on. 
Choices are 
rectangular and 
circular. 

Click on drop-down 
list to select 

 or 
 

dimension to base 
design on. 

The NRCS design 
methodology is 
used unless the 

is checked. 

Vary depth and 
bottom width to 
accommodate 
the site. 

 
Enter the number of years for sludge 
accumulation.   At least 1 year of sludge 
accumulation period should be entered to 
account for sludge buildup in the lagoon. 

AWM computed 
dimensions for 
the example 
shown. 



Design Screen 
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The following screen illustrates a circular anaerobic lagoon with external storage design 
based on using the Rational Design Method: The NRCS design 

methodology is 
used unless the 

is checked. 

 

Click on drop-down list to 
select shape of the pond to 
base the design on.  
Choices are Rectangular 
and Circular. 

Vary depth to 
accommodate 
the site. 

Enter the number of years for 
sludge accumulation.   At least 1 
year of sludge accumulation period 
should be entered to account for 
sludge buildup in the lagoon. 

 

Storage depth is the total depth of the lagoon less freeboard.  Since al 
storage do not provide storage, an additional storage component mu f 
facility in the management train.   

 

AWM computed
dimensions for 
the example 
shown. 

lagoons with extern
st follow this type o
Page 61 
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Page 62  AWM User Guide 

The following screen illustrates the soil liner design option for an anaerobic lagoon with 
external storage: 

 

 

Click on  to access the conversion 
calculator.   The calculator can be 
used to convert centimeters per 
second to feet per day.  See the 
Calculator section in this chapter for 
more information.  

Enter the permeability of the soil 
to be used for the liner.  This 
value is normally available from 
the soil mechanics report. 

Click on 
 

to access the 
soil liner design 
screen. 

Enter the allowable specific 
discharge.  This value may 
be based on regulatory 
requirements. 

The liquid depth AWM uses for designing the soil liner is based on the total depth of the 
lagoon less freeboard.  
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The Conversion Calculator is available within all screens in AWM and is activated by 
clicking on the Calculator button on the AWM tool bar or selecting the Unit Conversion 
Calculator from the Tools drop-down menu. The calculator can be used to perform 
mathematical calculations but is provided primarily for unit conversion. Select the To and 
From units in the combo boxes, type in the number to be converted and press the Convert 
button. 
 
The following screen illustrates how the Calculator can be used to convert units: 
 

Enter the value of the unit to 
convert.  This example is 
converting 2 Acres to Square 
Feet.  

Click on the drop-down list for 
unit type to select the type of unit 
to convert.  Area is selected for 
this example.  

Click on the “From:” drop-down 
list to select the unit to convert 
from.  Acre is selected for this 
example.  

Click on the “To:” drop-down list 
to select the unit to convert to.  
Square foot is selected for this 
example. 

Click on the Convert button to 
perform the conversion. 
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The following screen illustrates the results of the conversion of 2 acres to square feet: 
 

 

The calculator displays the value 
in square feet of the conversion 
of 2 acres shown in the previous 
screen.  

The numeric keys on the 
calculator can be clicked on to 
perform mathematical 
calculations.   The numeric keys 
on the computer keyboard can be 
used for this purpose as well. 

 
The data used in the conversion 
calculator can be edited by 
selecting Tools->Options from 
the main menu in AWM. 

 



Conversion Calculator
 

 

AWM User Guide  Page 65 

 

Click on the Calculator 
tab and the 

 
button to edit existing 
conversion data or add 
additional conversion 
data.   
 
If the  
box is checked the unit 
conversion factor will be 
available for use in the 
calculator. 
 

Click on the  
button to add additional 
conversion factors. 

 
 
The user should have a good understanding of the data format before attempting to edit or 
add data to the Conversion Calculator database.
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Manure Master is a simple screening tool can help assess the relative potential for the 
nutrients contained in the animal manure from an animal feeding operation to meet the crop 
uptake and utilization requirements for those crops that receive applications of manure.  
Manure Master calculates a balance between the nitrogen, phosphorus, and potassium 
content in the manure and the quantity of these nutrients used by crops. This balance can be 
calculated based upon recommended fertilizer application rates, when known or upon 
estimated plant nutrient content, when recommended fertilizer application rates are not 
known.  For nitrogen, the balance is calculated taking into account expected losses from 
leaching, denitrification, and volatilization. Manure Master is not a nutrient management 
planning tool, therefore criteria in the NRCS Practice Standard 590, Nutrient Management, 
should be referenced when developing nutrient management plans. 
 
The following screens illustrate the use of Manure Master: 

 

Click on the 
 

button to clear 
the input table. 

Click on the 

 button 
to view help. 
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Click on the 

 
button to view nutrient 
balance. 
 
Enter the acres of each 
crop that manure and 
waste water is applied 
on.   
 
Enter the target yield 
goal for each crop in 
the units indicated next 
to the Yield Goal 
column. 
 
Click on the  check 
box to indicate manure 
and waste water are 
incorporated into the 
soil when applied.  
Leave blank if manure 
and waste water is not 
incorporated. 
 
If available, enter 
recommended nitrogen,
phosphorous, and 
potassium application 
rates in pounds per 
acre. 
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The following screen illustrates output from Manure Master based on the previous screen: 



Manure Master 
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The following screen illustrates options for Manure Master output: 
 

 

Click on the  
button to view help.   
 
Click on the 

 
button to create a rich 
text format (.RTF) file of 
the output form.  
 

Click on the  
button to print the 
Manure Master output 
form. 
 
Click the  button to 
close the output form 
window. 
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Chapter 5 – Reports 
 
AWM generates several different report formats to document the system design. The reports 
are generated from File->Reports on the main AWM menu as shown below: 

 
Click on the preferred menu item 
in the drop-down list to print, 
preview or export a report.   

Previewing and Printing a Report 
Selecting the Preview Report results in the following screen for the example design: 
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Click on the  
check box to show sub 
reports.  

Click on the  
check box to show state 
custom reports. 
Click on a report to highlight
it and then click on the 

 button to preview 
the highlighted report.
 AWM User Guide 
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Selecting the Animal Waste Management Plan report to preview results in the following 
screen for the example design: 

 

A security warning popup 
may appear.  Simply click 
on the  
button to view the report.  

 

Clicking on the button will produce the following results: 

 
The AWM program uses Microsoft Access to preview and print a r
tools within Microsoft Access the user can export a report to a Mic
so it can be formatted and saved by the user.  The only limitation to
Click on the  button to 
view the report as a rich 
text format (.RTF) file in 
Microsoft Word.  The report 
can also be saved as a rich 
text format or document 
(.doc) file using Microsoft 
Word.  

Use the zoom  tool to 
click on the report to zoom 
in or out on the report. 

Click on the  button to 
print the report to the 
default Windows printer.  
Use the File menu or press 
the [Ctrl] + [P] to select a 
different printer to print the 
report with. 
Use the  
buttons to preview different
pages of the report.  The 

 button previews the 
next page and the  
button previews the 
previous page.  The  
button goes to the last 
page in the report and the 

  button goes to the first 
page in the report. 
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for use in the AWM program is the user’s knowledge level on how to create and edit reports 
using Microsoft Access. 
 
To print a report, select the Print Reports from the Reports menu as shown on the following 
screen: 

 
Selecting the Print Reports results in the following screen for the example design: 

 

Click on the  
check box to show sub 
reports.  

Click on the  
check box to show state 
custom reports. 
Click on a report to highlight
it and then click on the 

 button to print the 
highlighted report.
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Exporting a Report 
To export a report to a Microsoft Word rich text format(.RTF) file, select the Export Reports 
from the Reports menu as shown on the following screen: 

 
Selecting the Export Reports results in the following screen for the example design: 

 

Click on a report to select it 
for exporting.  

Click on the appropriate  
button to select a Microsoft 
Word rich text format 
(.RTF) file or EMF file. 
Click on the 

button to export the 
selected file. 
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Clicking on the  button results in the following screen 
for the example design: 

 

Select the directory to 
store the exported report 
file in.  
Enter the file name of the 
exported report file. 

Click on the  
button to open the report 
in the selected export 
file format. 

Clicking on the  button results in the following screen for the example design: 

 
Use the features of the selected program to edit and save the custom report. 
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Chapter 6 – Modifying the 
AWM Database 

 
 
The AWM database has four tables, all of which can all be modified.  They are: 

• Climate 
• Animals 
• Bedding 
• Separators 

 
Note:  Changes made to the database do not take affect until AWM is exited and then 

restarted. 
 
The tables within the AWM database are accessed from the main AWM menu by first 
clicking on Data and then clicking on the table to be modified as illustrated in the following 
screen: 

 
 

 
Select the data table to edit by 
clicking on the data element. 

 
 
If AWM is being used for the first time, the database may not be the most up-to-date 
database available. Refer to Chapter 2, Installing and Starting AWM for instructions on how 
to download the current database from the NRCS National Water and Climate Center 
webpage. 
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Editing Climate Data 
 
There are several ways that climate data can be edited or added to the climate data table.  
Each method is described in the following instructions. 
 
To edit existing climatic data, select the Data -> Edit Climate Data and the following screen 
will appear:  

 

Click on the 
 button 

to view the 
following screen. 

 
Click on cell to 
be edited and 
then type in 
new value. 
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The following screen illustrates how to add a climate station to the climate database: 

 

 

After completing data entry for new climate stations, close the Edit Clim

clicking on the  in the upper right hand corner of the screen.  After e
AWM, the new climate station will have been positioned in alphabetica
county, and climate station.  
 
Importing Climate Data 
 
You can import climate data from a file that is in comma delimited form
have all of the fields in the same order as they appear in the climate data
should not have a header row and should have one climate station per li
as many lines as desired.  When importing data, if a value already exists
box will popup and ask if it is OK replace the value that is in the databa
 
There are several ways to build a data file for import into AWM.  One w
Microsoft Word to develop the data and then save it as a text file(.txt).  
Microsoft Excel to develop the data and then save it as a comma delimi
order of data is State, County, Station, 25-year 24-hour precipitation, Ja
February precipitation, March precipitation, April precipitation, May pr
precipitation, July precipitation, August precipitation, September precip
precipitation, November precipitation, December precipitation, January
February evaporation, March evaporation, April evaporation, May evap
evaporation, July evaporation, August evaporation, September evaporat
evaporation, November evaporation, December evaporation, Barth’s Kv
volatile solids loading rate, volatile solids loading rate for odors and Ra
maximum anaerobic lagoon volatile solids loading rate.   
 

Enter State 
Abbreviation. 
Enter County 
Name. 
Enter Climate 
Station Name. 
Click on the 

 button. 
Click on the 

 
button to 
continue. 
Enter climatic 
data for the new
station. 
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Page 78  AWM User Guide 

An example of one line of climatic data follows: 
OR, East, New, 4.00, 6.90, 4.79, 4.33, 2.29, 2.09, 1.39, 0.35, 0.57, 1.46, 3.98, 6.08, 6.85, 
0.26, 0.52, 1.04, 1.82, 3.12, 3.90, 5.72, 4.68, 2.86, 1.30, 0.52, 0.26, 0.60, 5.25, 
0.0038,0.00625 
 
Each line of the file should have 34 pieces of data separated by commas.  The import will fail 
if this convention is not precisely followed.  A space after the commas may be included or 
not used. 
 
The following demonstrates saving the above line of data entered into Microsoft Word as a 
text file: 

 
From the Microsoft Word main menu click on File -> Save As and the following window 
will appear: Select a directory in 

which to save the 
file. 
 
Type in file name.  
 
Click on drop-down 
list and select 

  

. 
 
Click on the 

 button 
to save the file. 
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The following demonstrates saving the above line of data entered into Microsoft Excel as a 
comma delimited text file: 

 

From the Microsoft Excel main menu click on File -> Save As and the following window 
will appear: 

  

Select the directory 
in which to save the 
file. 
 
Type in file name.  
 
Click on drop-down 
list and select 

 button to 
save the file. 

. 
 
Click on the 
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The following demonstrates importing a climate data .csv file into the AWM database: 

  

Click on 

 
button. 

This action results in the following screen: 

  

Change to the 
directory where the 
file to import is 
stored. 
 
Click on drop-down 
list and select 

. 
 
Select the file to 
import. 
 
Click on the 

 button to 
import the file. 

The following dialogue box will appear if the file was successfully imported: 

  
 
The imported file will appear as th
exiting and restarting AWM, the re
county and weather station. 
 
A climate file developed in Micros
described for a text file but instead

 file type. 
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Click  button. 

e first line for the State in the climate data table.  After 
cords will be resorted into alphabetical order by state, 

oft Word can also be imported using the same procedure 
 of selecting a  file type you select  
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Deleting Climate Data 
 
The following demonstrates how to delete a line of climate station data from the climate data 
table: 

 

Click here to highlight 
the line of climate 
station data to be 
deleted.   
 
Press the [Delete] key 
on the computer 
keyboard to remove 
the line of data. 
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Editing the Animal Data 
 
The animal data table can be edited two ways.  One way is to edit data that already exist in 
the table and the other is to add data.  The animal table does not have an import feature. 
 
The following screen illustrates how to edit data in the animal data table: 

 

Click on the input 
cell and then edit 
or replace the 
existing data. 

 
The following screen illustrates how to delete a animal from the animal data table: 
 

 

Click here to 
highlight 
animal line to 
be deleted. 
 
Then press 
the [Delete] 
key on 
computer 
keyboard to 
remove the 
line of data 
from the 
database. 
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The following screen illustrates how to add animal data to the animal data table: 
 

 
 
The added animal is placed on the first line in the data table.  The followin
an animal named “New Cow” added using the procedure above.  Animal d
Cow” is added by clicking on the appropriate input cell and entering the d

 

 
After quitting and restarting the program, the new animal added will be so
alphabetical order by Name and Data Source. 
 
Animals added that are lactating are indicated with a one (1) in the “Is Lac
This is to associate the animal with a flush water volume indicated in the “
column in the Flush Water Calculator on the Additions Screen. 
 

 
Enter the name of 
the animal to add. 
 
Click here to 
access the drop-
down list of 
animal types.  
Click on an animal
type to select it. 
 
Select a State 
from the 
dropdown list and 

click on  
button to add the 
animal type 
selected to the 
data table.

g screen illustrates 
ata for the “New 

ata. 

 

 

 

rted i

tatin
Flus
Animal added.
 
Enter animal 
data in accord
with 
descriptions 
and units 
shown on the 
table.
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Editing the Bedding Data 
 
Editing the bedding data table is very similar to the editing the animal data table.  Data may 
be edited within the data table or new bedding data can be added or existing bedding data 
deleted.  The following screen illustrates how to add bedding data called “New Bedding”: 

Enter the name of 
the bedding data 
to be added.  In 
this example “New 
Bedding” is being 
added.  

Click on  
button to add the 
“New Bedding” 
data.  The “New 
Bedding” data 
appears on first 
line. 
Enter the density 
in pounds per 
cubic foot of the 
“New Bedding”. 
Enter the effective 
density of the 
“New Bedding” in 
pounds per cubic 
foot. 
Enter the State for 
which the “New 
Bedding” data is 
for. 
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The following screen illustrates how to edit existing bedding data: 

 

Click on the input 
cell and then edit 
or replace the 
existing data. 

 
The following screen demonstrates deleting bedding material from the bedding data table: 
 

 

Click here to 
highlight the row of 
the bedding data to 
be deleted. 
 
Press the [Delete] 
key on the computer 
keyboard to remove 
the line of bedding 
data. 
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Editing the Separator Data 
 
The separator data table contains efficiency values for liquid/solid separators by the type of 
separator.  Data may be edited within the data table, a new separator can be added, or an 
existing separator can be deleted.  Adding a separator called “New Separator” is 
demonstrated on the following screen: 

 
 
Editing the efficiency value for a separator in the data ta
screen: 

 

Enter the name of the separator 
to be added.  In this example  
“New Separator” is being added. 
 

Click on the  button to add 
the “New Separator” to the data 
table. 
 
The “New Separator” will be 
added to the data table and will 
appear on first line. 
 
Enter the separator efficiency as 
a decimal for the “New 
Separator”. 
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ble is illustrated on the following 

Click on the input 
cell and then edit 
or replace the 
existing data. 
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Deleting a line of separator data is illustrated on the following screen: 

 

Click here to 
highlight the row of 
the separator data to 
be deleted. 
 
Press the [Delete] 
key on the computer 
keyboard to remove 
the line of separator 
data. 
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